Network Visualization using Gephi

Gephi

makes graphs handy

Ted Polley and Dr. Katy Borner
Cyberinfrastructure for Network Science Center
Information Visualization Laboratory
School of Library and Information Science
Indiana University, Bloomington, Indiana, USA

Please download Gephi at
Please download Sci2 at
Documentation can be found at
Also check out

Cyberinfrastructure for Network Science Center
School of Library and Information Science
Indiana University Bloomington
LIO01 Wells Library
Monday September 17, 2012 — 6:00pm-7:00pm


http://cns.iu.edu/
http://gephi.org/
http://sci2.cns.iu.edu/
http://wiki.gephi.org/
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Gephi

Workshop Overview

makes graphs handy

Introduction to Gephi

* User Interface
— Overview
— Data Laboratory
—  Preview

*  File Formats Supported by Gephi

*  Extending Gephi with Plugins

* Load Networks into Gephi from Sci2

*  Opening the Network in Gephi

*  (Calculating Graph Metrics

*  Network Layout

* Ranking the Size and Color of the Nodes
*  Scaling the Size and Color of the Nodes

*  Enhancing Visualization

— Adding node labels

— Adjusting node labels

— Expanding the layout area

— Using filters to reduce network size
*  Finalizing in Preview
*  Exporting Network with Seadragon



Gephi

Gephi - Introduction

makes graphs handy

* Gephiis an open source tool
designed for the interactive

exploration and visualization of S
networks R ARG

* Designed to facilitate the user’s e
exploratory process through =
real-time analysis and T
visualization

* Visualization module uses a 3D
render engine

e Uses the computer’s graphic
card, while leaving CPU free for _ P 5
computing — . , : - -

O ANNN O

e Highly scalable (can handle over
20,000 nodes)

* Built on multi-task model to take
advantage of multi-core
processors

Bastian, Mathieu, Sebastien Heymann & Mathieu Jacomy. (2009). Gephi: an open source software for exploring and

manipulating networks. International AAAI Conference on Weblogs and Social Media. From
http://www.aaai.org/ocs/index.php/ICWSM/09/paper/view/154



Gephi

makes graphs handy

User Interface - Overview
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makes graphs handy

User Interface — Data Laboratory

File Workspace View Tools Window Plugins Help =
) Overview ‘ [ 7] DataLaboratory | ‘ ] Preview \un
e
= DetaTable | EE
Edges | & Configuration | 0 Add node (-!-) Add edge u Search/Replace @i Import Spreadsheet L—i Export table ﬁ More actions v Filter: :Nodes - Y,
Nodes Id Label number_of_authored_works  times_cited totaldegree
# Eaghe, L n0 Eaghe, L 34 357, 5/ 4
# Ramachandran, S ni Ramachandran, S 2 6 1 b
# Dastidar, Pg n2 Dastidar, Pg 3 14 1
# Daniel, Hd n3 Daniel, Hd 7 120 6
# Bornmann, L n4 Bornmann, L 6 115 4
# Nast, I n5 Nast, I 1 0 2
# You, ] né You, ] 2 8 1
# Vaughan, L n7 Vaughan, L 5 13 5
# Moon, Hs n8 Moon, Hs 3 2 2
# Yoo, Sh ng Yoo, Sh 2 0 1
# Somoza, M ni0 Somoza, M 1 0 4
# Barrios, M ni1 Barrios, M 2 0 6
# Borrego, A ni2 Borrego, A 2 0 6
# Vilagines, A ni3 Vilagines, A 1 0 4
# Olle, C ni4 Olle, C 1 0 4
# Frias, A nis Frias, A 1 0 3
# Vilarroya, A ni6 Villarroya, A 1 0 3
# Jarneving, B ni7 Jarneving, B 4 9 1
# Vihinen, M ni8 Vihinen, M 1 0 1
# Riikonen, P nis Riikonen, P 1 0 1
# Rousseau, S n20 Rousseau, S 4 35 1
# Larsen, Po n21 Larsen, Po 4 22 4 =
-
[ @ il il (i i (i it i e !;
Add Merge Delete Clear Copy data to Fill column Duplicate Create a boolean column | Create column with list of Negate L
column columns column v | column v | other column v | with a value v | column v from regex match v | regex matching groups v boolean values v I
| Workspace 0 4 »




File Workspace View Tools Window Plugins Help —
| @ Overview i l || Datalaboratory ! [ L] Preview n
7\

Preview Settings % I =l | |62 Preview sa‘ EHE

# Presets =]

Defauit Straight
[=I Nodes -

Border Width 1.0

Border Color custom [0,0,0] 8

opacity 100.0
I=I Node Labels

Show Labels [«

Font Arial 12 Plain -~ [

Proportional size |

Color custom [0,0,0] @

Shorten label |

Max characters 30 =

Outline size 0.0 1

Outline color custom [255,255,... [..]

Outline opacity 80.0

Box D

Box color parent E]

Box opacity 100.0
[-IEdges

Show Edges 7|
Thickness 1

Rescale weight [ 5

Color mixed (&)

Opacity 100.0

Curved |

Radius 0.0
[=|Edge Arrows
Size 3.0
[=/Edqge Labels X

Preview ratio: 100%

U @ Refresh
Export: SVG/PDF/PNG [] Background Resetzoom - +
| Workspace0 4 »




Gephi Loading Data — File Formats
Supported by Gephi

makes graphs handy

e CSV

DL Ucubet

e DOT Graphviz

* GDF

* GEXF

e GML

 GraphML

* NET Pajek

e TLP Tulip

* VNA Netdraw

* Spreadsheet — Node tables and edge tables
can be loaded into the data laboratory only



Gephi

makes graphs handy

Gephi offers an extensive
plugin library for extending
the functionality of the
tool

Seadragon Web Export can
be used to export your
visualizations for dynamic
network exploration on the
Web

Seadragon allows users to
zoom-in on particular parts
of a network much the way
Google Maps allows users
to zoom-in and pan across
a map.

Extending Gephi by Adding Plugins

% Seadragon Web Export

P
’ 1

o



Gephi

makes graphs han

(7] Overview

Plugins

Preview Settings % Options

Language

To add the Seadragon
plugin go to Tools > Plugins

Then select the Available
Plugins (36) tab and find
the Seadragon Web Export

plugin

Select the plugin and click
Install

You will be prompted to
restart the Gephi

File Workspace View |Tools| Window Plugins Help

Extending Gephi by Adding Plugins

-~ -
‘ L Preview ‘ \‘un
N
El LG
»
Plugins P9

Updates | Available Plugins (36)

Downloaded \\ Installed (30) ‘ Settings

‘ Reload Catalog ‘

Install Name Category 7
Graph Streaming Plugin
HttpGraph Plugin
ClusteringChineseWhispers Plugin
DAGLayout Plugin
Script Console Plugin
SemanticWebImport Plugin
CoordinateView Plugin
ARFLayout Plugin
Java Class Dependency Plugin
Linkfluence Plugin Plugin
Complex Generators Plugin
Data laboratory helper Plugin
Geolayout Plugin
GraphvizLayout Plugin
SNAMetricsPlugin Plugin
Loxa WebSite Export Plugin
LayeredLayoutPlugin Plugin
NoverlapLayout Plugin

 Seadragon \ rt Plugin

Parallel Force Atlas

[ Install J 1 plugin selected, 85kB

MultimodeNetworksTransformatio. .

Plugin
Plugin

=4 E%EE S e g

>

m

1

Seadragon Web Export
iy Community Contributed Plugin

Version: 0.3.1

Author: Mathieu Bastian, Julian Bilcke
Date: 3/29/12

Source: Gephi Thirdparties Plugins

i http://gephi.org/plugins/seadragon

Plugin Description

Search:

Export networks on the web with the Seadragon dynamic exploration tool.

@ When a graph is loaded, go to “File > Export > Seadragon Web" and get the

HTML file with the Seadragon widget ready to use.

® Zoom and pan into the graph

@ Seadragon is pure Javascript and works on all browsers
@ As it uses image tiles (ke Google Maps), there is no graph size limit

@ Export is similar as PDF and includes all settings from Preview

See

o OLL il i S dbms Ll i Lol i Lo i i i

Close

m

[] Background Resetzoom - +

10



Gephi Loading Data — Opening Networks
makes graphs handy DI rectly fro m SC| 2

File DataPreparation Preprocessing Analysis Modeling Visualization R Help

El Console = O || 4 Data Manager =B

[ 11 yUU TISCU IS WLl yUUT GIIG1y3C3, 116VE (UESLIUIS GUUUL UGLA3TLY, Ul WUUIU IR LU SUyyest [ P - - " =5
' ~ 4 [ i1 ISI Data: C:\Users\dapolley\Download:|

Netwo rkS can be FT] 2126 Unique ISl Records

fiana University and Kevin W. Boyack, SciTech Strategies Inc. The Sci2 tool was developed by Chin
Smith, David M. Coe, Micah W. Linnemeier, Patrick A. Phillips, Chintan Tank, and Russell J.

extracte d frO m raw ell (http://cishell.org) developed at the Cyberinfrastructure for Network Science Center
Many algorithm plugins were derived from the Network Workbench Tool
data using Sci2: File >

I_O a d > i2) Tool. Indiana University and SciTech Strategies, http://sci2.cns.iu.edu.

m

scientometrics.isi

essed to remove duplicate unique ISIIDs leaving 2126 records.

Wrote log to C:\Users\dapolley\AppData\Local\Temp\isiduplicateremoverlog304725851300681353.txt
Loaded: C:\Users\dapolley\Downloads\Scientometrics.isi

E] Scheduler =iH

l Remove From List Remove completed automatically | Remove all completed

! Algorithm Name Date Time % Complete

This dataset includes all
articles (2,126) published in

the journal Scientometrics
from 1978-2008




Gephi Loading Data — Opening Networks
makes graphs handy Dlrectly from SC|2

4 Sci2 Tool
File | Data Preparation | Preprocessing Analysis Modeling Visualization R Help
= ( Remove ISI Duplicate Records = B || pata Manager = (@]
;:I:g Remove Rows with Multitudinous Fields FIVIES, GUUGE UGLasehs, L WoUlG RS EUSLYYESE R B ﬁ 151 Data: C:\Users\dapolley\Download:
P e F71] 2126 Unique ISI Records
Prirm i i yategies Inc. The Sci2 tool was developed by Chin
Hua Extract Bipartite Network fick A. Phillips, Chintan Tank, and Russell J.
Duh Extract Paper Citation Network frastructure for Network Science Center
htt Network Workbench Tool
Ehtt: Extract Author Paper Network LS
Plea Extract Co-Occurrence Network
Sci2 Extract Word Co-Occurrence Network ks, http://sci2.cns.iu.edu. ,
Egﬁ: Extract Co-Author Network # ' Extract Co-Author Network I&J
Four Extract Reference Co-Occurrence (Bibliographic Coupling) Network 7
Fout Extracts a co-authorship network from one of several supported
Four Extract Document Co-Citation Network file t}’pES.

121261

Extract a Co-Author bosét3| File Format [is -] (@]
Network from 2126 ]
Unique ISI Records’

(5] (Gl

— = = — —_————————1))

ically | Remove all completed

Data Preparation >
Extract Co-Author Time % Complete |
Network




Gephi Loading Data — Opening Networks
makes graphs handy Dlrectly from SC|2

File DataPreparation Preprocessing | Analysis | Modeling Visualization R Help

E Console Temporal L = O || i Data Manager =08
S E - :

Please cite as follows: Genspatial 4 - a fj ISI Data: C:\Users\dapolley\Download|

Sci2 Team. (2009). Science of Science (Sc Topical » Bnd SciTech Strategies, http://sci2.cns.iu.edu. a [j 2126 Unique ISI Records |

Found old-style ISI/Web Of Knowledge f Networks » Network Analysis Toolkit (NAT) %", Extracted Co-Authorship Netw|

Found old-style ISI/Web Of Knowledge fl. .. - i | P . dhacinfammation |

Found old-style ISI/Web Of Knowledge file. Unweighted & Undirected > Node Degree

/Web Of Knowledge file

Weighted & Undirected » Degree Distribution
to remove duplicate i i »
A p p e n d t h e n O d e £ Hieghted 02 e tec K-Nearest Neighbor
NTemp\isiduplicater Weghted & Dvected f Watts-Strogatz Clustering Coefficient

d eg re e tO t h e n etWO r k i Watts Strogatz Clustering Coefficient over K

Diameter

AnaIYSiS > Networks > Average Shortest Path

y/CISHELL/Extract+Co-Author+Network+%28Text+Files%29 S
U . hted & Shortest Path Distribution
We I g Node Betweenness Centrality
U n d i re Cte d > N O d e Weak Component Clustering
Global Connected Components
Degree

utomatically | Remove all completed Extract K-Core

Annotate K-Coreness
Blondel Community Detection
! Algorithm Name Date Time % Complete

HITS
| Extract Co-Author Netw... 09/25/2012 02:43:00 PM — ™




Gephi

makes graphs handy

A Sci2 Tool

File Data Preparation Preprocessing Analysis Modeling | Visualization | R Help

Console General > l
T R T T T s Temporal » !
Found old-style ISI/Web Of Knowledge file. .

Found old-style ISI/'Web Of Knowledge file. Geospatial »
The original 2126 records have been processed to remove duplid Networks »
Wrote log to C:\Users\dapolley\AppData\Local\Temp\isiduplicz Topical 4
Loaded: C:\Users\dapolley\Downloads\Scientometrics.isi Balloon Graph (pref

Select the ‘Network with
degree attribute added to

tract+Co-Author+Network+%28Text+Files%2

node list’ and run

Visualization > Networks >
Gephi

pde+Degree

Remove From List‘ Remove completed automatically | Remove all completed

Loading Data — Opening Networks
Directly from Sci2

= O || 4 Data Manager =0

E ISI Data: C:\Users\dapolle;"\Download:!
4 [ 2126 Unique IS Records

GUESS iship Netw
-gree attribi

A 4

Cytoscape

Radial Tree/Graph (prefuse alpha)
Radial Tree/Graph with Annotation (prefuse beta)

ree View (prefuse beta)

Force Directed with Annotation (prefuse beta)

Fruchterman-Reingold with Annotation (prefuse beta)

DrL (VxOrd)
Specified (prefuse beta)

Circular Hierarchy
Gephi

Bipartite Network Graph

m

! Algorithm Name Date Time % Complete
| Node Degree 09/25/2012 02:49:06 PM
V] Extract Co-Author Netw... 09/25/2012 02:43:00 PM
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When you open a network in

Opening the Network in Gephi

Gephi from Sci2 you will be

presented with an import

report. Click OK

Import report

Source: Graphml-for-gephi5515348742594822293.graphml

Nodes Issues
| €D Default edge type set as UNDIRECTED fiINFO
Graph Type: Undirected v (V| Auto-scale
# of Nodes: 2217 /| Create missing nodes
# of Edges: 2931 @ New graph
Dynamic Graph: no Append Graph
Hierarchical Graph: no Tine Fame

[ OK J‘ Cancel ‘




Gephi

Opening the Network in Gephi

makes graphs handy

B cepniveoen - e o S,

File Workspace View Tools Window Plugins Help ' I
{U Overview | 1 ||| DataLaboratory 1] (- Preview [ \un
| partition hking sei = ' Graph 33[ 413 ](=] [ statistics 88} =
Ed Cll® B AR bragging @ Hierarchy :SEtﬁngS
— . . ol k -
¥ When the network is fist loaded, I BRSSO Hcs
Average Degree Run ®
it may load in the preview s, Weighted Degree fun
H M H Network Diameter Run
window. If this happens, switch to
Graph Density Run @
the Overview window to perform s A
a n a Iys i S Modularity Run
= 9 Foe : . PageRank Run
[Layout S/J E] | Connected Components Run
---Choose a layout v [*] Node Overview
Ava. Clustering Coefficient Run
Eigenvector Centrality Run
[*] Edge Overview
Avg. Path Length Run
4(:},.
a
size
A
®|*
A
¥ presets... Reset le&-|TEEET A- A- ArialBold, 32 { [ [} &
Workspace 0 4 »

16



Gephi

makes graphs handy

{25 Gephi 0.8.1 beta

Workspace View Tools Window Plugins Help

Overview .| DataLaboratory L Preview

& | x|

Before you conduct any analysis
or visualization it is a good idea to
save the network you have SEE
loaded into Gephi as a .gephi file
on the desktop or some other
space.

| ition Ranking &

lley, David Edward
min

eresting datasets

Presentations
---Choose a layout v { Research
My Documents rivermaps
sci2
p: L VOSviewer_1.5.2_exe
e “ wrkshp.gephi
Computer
Pe- N p S
\.\q File name: wrkshp | save |
Network 1
Files of type: | Gephi Files (=.aephi) e [ Cancel |

n
L

= ® = &

| A- A- Arial Bold, 32 i

|2 - TEC@ET 1

A [ statistics | Fitters = | = |

@ Hierarchy

(=]

Reset ;

Opening the Network in Gephi

Library
Attributes
Dynamic
Edges
Operator
Topology
Saved queries

T Queries

@ Drag fiter here

Select ] D> Filter \ 17

Workspace 0 « »




Gephi Calculating Basic Network

makes graphs handy .
Metrics
sepri0s10et - et 0 S, -

File Workspace View Tools Window Plugins Help |
N N7 e |

‘ (7] Overview ‘ [ Data Laborator L Preview

Basic network, node, and edge metrics
can be calculated using the statistics
window. To calculate a particular metric

Statistics 2 [=]
v Partition Ranking ® VV i |
; INodes Edges i

-—Choose a rank parameter

Settings

[+] Network Overview

Average Degree Run
click Run and a report will be
generated. If the statistics window does oAl e
not automatically appear, follow N Dot ol
=h 4 Window > Statistics at the top of the Graph Density Run
E—— tool. HITS Run
Modularity Run
PageRank Run
Connected Components Run

[*] Node Overview

0 Ava. Clustering Coeffident Run
A Eigenvector Centrality Run
A

A [+] Edge Overview

les- | TEEET -1 A- A- ArialBold, 32 I m: | Ava. Pathlength Run

TOIRepate s = ¢ T




Gephi Calculating Basic Network

Metrics

File Workspace View Tools Window Plugins Help

makes graphs handy

‘y Qverview ‘ ||| DataLaboratory [ [ Preview

—

T — |
In this example the average Degree Report
degree was calculated and
represented on a degree e
distribution scatter plot. Degree Distribution
This type of analysis is |
useful for understanding = |
your network prior to |
visualization. :
\
- |
|
\
e B print B copy [ save
3
|2=-TREET -1 | A- A- AvialBold, 32 i i e




Gephi

Laying out the Network in Gephi

makes graphs handy

File Workspace View Tools Window Plugins Help

- -~ -
l () Overview ! || Datalaboratory L] Preview \dun

Partition | Ranking % = VGraph % I [context = =
Nodes | Edges v A A (QP Dragging @ Hierarchy Nodes: 2217 (€
| = 5 1| Edges: 2931
-—Choose a rank parameter g Y Undirected Graph
D Statistics # | Filters | =
Settings
; |
[z} Network Overview
Average Degree Run
#
—/ Avg. Weighted Degree Run
7 i D Network Diameter Run
al Graph Density Run
= :
a HITS Run
Layout %l E)‘ L3
[ 1 Modularity Run
‘Frurhterman Reingold .
Contraction = PageRank Run
Counter-Clockwise Rotate
Run
[Expansion
Force Atlas = h k H I I I d H d
The network will load in a random s
Label Adjust I f d Th f' H | | Centrality Run
Random Layout - cluster of nodes. e Tirst step wi

erview

be to choose a layout to make the g
network more visible.

Fruchterman Reingold

Choose layout option and select:
Fruchterman Reingold

7 Ppresets... Reset y | A- A- Arial Bold, 32

Workspace 0 4 »




Gephi

vl | aving out the Network in Gephi

J Gephi 0.8.1 beta - Project C=rE

File Workspace View Tools Window Plugins Help

—
’ (] Overview ||| DataLaboratory | (- Preview \Un
> N

Partition % | Ranking | El || Graph 3| ajeby B [context | =
@Edges i & (,gp Dragging @ Hierarchy Nodes2a 17 \3
: 1 Edges: 2931
(6°4] - 4 %
& | | L Undirected Graph
St.. | Filters =
D Settings
4

[*] Network Overview

Average Degree
| Avg. Weighted Degree

Network Diameter

e J \ Graph Density
Layout 2 | HITS
Fruchterman Reingold Modularity

) You can change the _» ——

=IFruchterman Reingold Connected Components

Area 10000.0
Gravity 10.0

layout parameters such | A
as area, gravity and 2 Avg. Custering Coeficent

Eigenvector Centrality
S p e e d . . [*] Edge Overview

Avg. Path Length

[*] Node Overview

size
‘ A
[ p= A
| Fruchterman Reingold L J
A
iV Presets... Reset o B " T D‘Uj 1 !J ! A- A- Arial Bold, 32 u -IE & < m »

Workspace 0 4 »




Gephi
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|| File Workspace View Tools Window Plugins Help

|\y Overview ‘ || DatalLaboratory L

Partition IRanking ® f
Nodes | Edges

times_cited

Min size: 1042 Max size: 50}

Range: || {

Spline... &

i)

Layout

Fruchterman Reingold

-!Fruchterman Reingold

Area 10000.0

Gravity 10.0
Speed 20.0

Fruchterman Reingold

V presets... Reset

Using Ranking to Enhance

Preview

Visualization

' Use the Ranking

function and then
select the nodes tab.

Then select to
resize nodes

Choose the

times_cited attribute
and set the input
parameters to the
following:

| Min size: 10
| Max size: 50

@ Hierarchy

Workspace 0 «

22



Gephi Using Ranking to Enhance
Visualization

makes graphs handy

File Workspace View Tools Window Plugins Help — =
‘w Overview ‘ "  DataLaboratory L g Preview )”, n
7~
Partition | anking % | rapl . ZE}
T X S = Use the Ranking rr—
number_of_authored_works v : ~‘: fu n Ct i O n a n d t h e n
Color: s Defauit [ I
. sai=—all sclect the nodes tab.
Range: U H Recent ) [ LI
[N |
o - o Then select to
[l | 1
=l colorize nodes
= : [ W |
Layout &
Fruchterman Reingold — g Ch Oose th e
® BEILE M number of authored
= Fruchterman Reingold R
ar o0 _works attribute and
set the input
parameters to the
following: pm
Fruchterman Reingold
V Ppresets... Reset | y B 'j T D | [ U .EJ; =]
Workspace 0 4 »

=)
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Gephi Scaling the Size and Color of the
makes graphs handy N O d e S

phi 0.8.1 beta - Project

|| File Workspace View Tools Window Plugins Help
-~ -
!Qy! Overview | Datalaboratory L Preview \un
FamN
Partition | Ranking % | &|| Graph x| EE
Nodes |Edges ‘ @7 A A (,(jp Dragging @ Hierarchy
number_of_authored_works -
s a s, " i i T re T -
Min size: 10/4]  Maxsize: 50 5 i e e A L
1 / ®ivy .2 R TN ’ :
Range: || {J ‘ e = L A RN S
. : .
Spline... = ‘ [> Apply ‘ = ‘o .« o WIIEP "'": ®:5 DS S :

- ||/ . s Ry I ¢ ‘e S S

Sees gt i

/ $ 2 e e e
X ® I AE '0.{; ey % 3
L] o > 1
) S S8
3 » . * . o L e
= L oo 3 0 B =
e 8 & P R B
- L .
s .0 S - ®

To change the scaling for the node size or RIS
node color click Spline. S ST P &

You can select from preset scales or
create your own.

Once you have decided on scale for 2 e e
either the node size or node color click L
Apply to scale the nodes in the network. & | & A aatoae, 2 ———— WS .

Workspace 0 4 »




Gephi Scaling the Size and Color of the

makes graphs handy

The default scale is linear. On this
graph node size (or color) is
plotted on the y-axis and the
attribute you have selected to size
by is plotted on the x-axis.

The linear scale means that if you
had a set of nodes with
times_cited values ranging form 1
to 100 and you wanted to size

those nodes from 1 to 50, you
assign a times_cited value of 1 to
size 1 and a timces_cited value of
100 to size 50.

This approach works well if the
times_cited values are normally
distributed, but what if they are
skewed?

Nodes

werone .~

Spline Editor
Draag control points in the display to change the shape of the spline

10.8

10.6

10.4

Templates

|

m

I Close

T e e NI MRS il

25



Gephi

makes graphs handy

What if your network contains
many nodes with a low
times_cited values and only a few
with a high times_cited value. You
may want to show the differences
between those nodes with a lower
times_cited value more clearly.

In this case you may want to
choose a logarithmic scale. The
scale to the right will show
differences in nodes with a
smaller times_cited value more
clearly, because the size increases
more rapidly in relation to the
times_cited value.

Nodes

Scaling the Size and Color of the

v .~

Spline Editor
Drag control points in the display to change the shape of the spline

10,8

10.6

Templates

I

m

Close

T e e TTRMNINT e T

26



Scaling the Size and Color of the
makes graphs handy N O d e S

Gephi

Spline Editor
Conversely, if you want to convey Drag control points in the display to change the shape of the spline ’n
the differences between the
nodes with a higher times_ctied ) fompaies ~
value more clearly and you are 1 | } | 3
less worried about nodes with | | |
smaller times_cited value, then 10.8 ,'"
you may want to choose a layout /
like the one the right. les //
é

This layout changes the size of
nodes with a higher timces_cited | |
value more drastically than nodes
with smaller times_cited. -

S Close |

0 ~—.._TO’:‘ I04 :0.6 0.8 ll




Scaling the Size and Color of the
Nodes

Gephi

makes graphs handy

XN

B5[E

Preview

For this network there are many

nodes with low times_cited L @ by
values and low number_of B At

authored_works values. Thus, ;'j ik,

the following scale was chosen - : ’

to make the differences in both SR G e B g HE _ _
size and color of the majority of Tossaeing ST vl KA AL, o

. . . . L v e * *
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Gephi Seadragon Export
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Instructions to put online

® Copy all files on your server.

| VV Krishnalah st
\ <rishnglah, Vs Raifls. D

T T T
NZDOA Van Leeuwen

T TNVENTR

Uteent b

® Use this HTML file as an example. copy the script and define a seadragon div in your page.

o Find help on the Seadragon AJAX website.

® Note that its not possible to preview Seadragon locally with Chrome browser.
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* Do you have any questions about the features
or capabilities of Gephi?

* Be sure to check out the Gephi forums if you
have any further questions

* Feel free to email me dapolley [at] indiana [dot] edu


https://forum.gephi.org/

